
Getting the most from 

Family Historian 6 

Simon Orde 



Copyright © 2016 Calico Pie Limited 
 
All rights reserved. 
Calico Pie Limited 
London, United Kingdom 
www.family-historian.co.uk 
 
This book, and the software described in this book are copyrighted.  All rights are reserved.  No part of 
this book, or the software described in this book, may be copied, reproduced, translated or transferred 
to any electronic medium without prior written consent of Calico Pie Limited. 
 
Published by Calico Pie Limited. 
 
 
 

Trademarks 
 
Google Maps is a trade mark of Google Inc.  Bing is either a registered trademark or a trademark of 
Microsoft Corporation. 
 
 
 

About the Author 
 
After many years designing and developing CASE tools (Computer-aided Software Engineering tools), 
financial packages and similar products for professionals, Simon Orde founded Calico Pie Limited with 
the vision of bringing the same quality of software tools to the world of genealogy.  He lives in 
London, U.K. 
 
 
 

http://www.family-historian.co.uk/


 

   

 

Contents 
 

Chapters 
 
Introduction .............................................................................................................................................. 1 
1. Getting Started with the Focus Window ........................................................................................... 3 
2. Editing Records with the Property Box ........................................................................................... 19 
3. Introduction to Diagrams ................................................................................................................. 31 
4. Pictures & Media Part 1: The Property Box .................................................................................... 41 
5. Pictures & Media Part 2: The Media Window ................................................................................. 49 
6. Facts & Notes in the Property Box ................................................................................................... 61 
7. Browsing, Searching & Editing in the Records Window ................................................................ 75 
8. Diagram-based Editing ..................................................................................................................... 83 
9. Setting the Style, Layout & Content of Diagrams ............................................................................ 89 
10. Smart Trees and Wall Charts........................................................................................................ 105 
11. Scaling & Printing Diagrams ............................................................................................................ 131 
12. Recording Your Sources .................................................................................................................. 137 
13. Web Search, Web Hints & Web Clipping ..................................................................................... 147 
14. Places, Maps and Timelines .......................................................................................................... 155 
15. Reports and Narratives ................................................................................................................ 163 
16. Books & Booklets .......................................................................................................................... 177 
17. Introduction to Queries ................................................................................................................ 187 
18. Writing Custom Queries ............................................................................................................... 197 
19. Projects: Compare, Merge, Split, Copy & Export ......................................................................... 211 
20. Named Lists and Record Flags ..................................................................................................... 225 
21. Website Generation and Other Wizards & Tools ........................................................................ 233 
Index ..................................................................................................................................................... 238 
 
 

Chapters and Sections 
 
Introduction .............................................................................................................................................. 1 

Check Your Software Version … The Sample Project … Find Sample Project & Reset It … Copy  Sample 
Project … GEDCOM … Transferring Data into Family Historian … Projects … Standalone GEDCOM Files … 
The Help … “How To” Help … Terminology 

1. Getting Started with the Focus Window ........................................................................................... 3 
Chapter Overview … The Project Window … The Family Historian Sample Project … The Navigation Bar … 
Workspace windows … The Focus Window … The Spouses & Children Tab … Select a Record … Set the 
Focus Person … Multiple Spouse Families … Add Parents … Undo/Redo … Add Children … Add Spouses … 
Add More Relatives … Add More Sets of Parents … Add Relatives Using the Add Menu … Add Unrelated 
Person … Add Grand-parents and Grand-children … Go Back & Go Forward Buttons … The Home Button … 
The Root Person (the File Root) … Make File Root … The Focus Button … Adopted, Fostered,  Step, etc. … 
The Marriage Box … Unmarried, Separated and Divorced Couples … Delete Record … Unlink Record … Re-
link Record … Change Order of Children … The Parents & Siblings Tab … Spouse Families & Parents 
Families … Keyboard Shortcuts … Features of the Parents & Siblings Tab … The Ancestors Tab … Add 
Ancestors … Switch Focus … Right-Click Menu … Navigate up the Ancestral Tree … Switching Focus and 
Tab … The Descendants Tab … Features of the Descendants Tab … More Features of Descendants  
Listings … Space Bar vs. Enter Key … Spouse Markings on Lines … Customize … Focus Window … Colours … 
Text Size … Generations … Other Options … Close Project … Tips for New & Upgrading Users … Autosave … 
Saving Changes to Projects … Create a New Project 

2. Editing Records with the Property Box ........................................................................................... 19 
The Property Box … The Data Pane … The Source Pane … The Main Tab … Gripper Bars … Reveal Hidden 
Fields … Undo/Redo … Entering Name Details … Don’t Use Capitals; Do Use Maiden Names … Use of the 



Contents 

ii 
 

Tab Key … Slashes Round Surnames … No Mandatory Fields … Same Sex Relationships … Alternate Names,  
Titles, Nicknames, etc. … Given Name Used … Birth & Death Details … Multiple Occupations, etc. … Helper 
Dialogs … Auto-Complete … How to Enter  Simple Dates … Date Validation and Date Phrases … How to 
Enter Complex Dates … Date Entry Assistant Dialog … Quick Ways to Enter Dates … Improbable Date 
Warnings … Spouse Tabs … Add Child … Change Order of Children … Change Order of Spouses … Add 
Spouse … Add Children of Unknown Parent … Go To Buttons … The Up Button (Go To Parents) … Go 
Back/Go Forward Buttons … Display in Focus Window … Go to Record … Show Sources … Sync with 
Selection … The Property Box Menu … Setting the Text Size and Font … Enter Accent Characters … 
Configure Language & Accent Characters … Sort Family & Events in Date Order … Customize Data Entry … 
Version 3 Compatibility … Property Box Options … Float/Dock  Property Box … Auto-Docking  and Auto-
Positioning … Close Property Box … How to Open the Property Box … You Never Have to Close the 
Property Box … Modeless Dialogs … Find Record … The Find Dialog … Help for the Property Box (F1) … 
More on the Property Box 

3. Introduction to Diagrams ................................................................................................................. 31 
Some of the Things You Can Do with Diagrams … View Ancestors … Navigation Bar Icon for Diagram 
Windows … About  Workspace Windows … How To Close Workspace windows … The Diagram Menu and 
Toolbar … Zooming In and Out … Fit Window … Diagram Options … Specify Number of Generations … 
Select Area to View … Centre Diagram … The Grabber … Expansion Buttons … The Property Box & the 
Diagram Window … Diagrams are Dynamic … View Descendants … Multiple Diagram Windows … Spouse 
Display Options … Box Types … The Diagram Root … Text Schemes … View Ancestors and Descendants  … 
View All Relatives … Interpreting the All Relatives Tree … Basic Diagram Options … Generation Stripes … 
Relationship Descriptions … Layered vs. Flat … Close the Diagram Windows … Use the Help 

4. Pictures & Media Part 1: The Property Box .................................................................................... 41 
Overview … Two Ways of Working … Video, Sound Files, and Other Media … The Property Box Media  
Tab … Add Media … Insert Video, Sound Files, Etc. … Insert Multiple Pictures … Drag-and-Drop … Copy 
Files into Project … Organizing Your Media Files … Adding Externally Linked Pictures … Why You Should 
Link to Faces … How to Link to Faces … Edit Media Item … Link Other Faces … Updating & Deleting  
Frames … Edit Picture Details … Keywords … The Links Field … Edit Link Details … Attach a Note to a Link … 
Exclude From Diagrams & Reports … Use Note as Caption … The Edit Media Item Toolbar … Media Tab of 
the Property Box … Media Tab Toolbar … Unlink or Delete … Preference Ordering of Pictures … Toggle 
Picture/ Thumbnail View … Show Face … Go To Media Record … View in Media Window … Open Editor/ 
Player … Pictures of Families … Pictures of Source Records … Pictures of Events and Attributes … How to 
Show Pictures in Reports 

5. Pictures & Media Part 2: The Media Window ................................................................................. 49 
The Media Window … Getting Pictures in Digital Format … Add Pictures using Add Menu … Add Pictures 
by Drag-and-Drop … Add Pictures from Clipboard … Add Videos, Sound Files, and Other Media … The View 
Media Button … Pictures of More Than One Person … Open the Sample Project … List Pane & Display 
Pane … The Media List … Select Pictures in the Media Window … Searching for Media … Find Using  
Query … Select … Keyword Filtering … Delete Media Records … File Links and Record Links … Work with 
External File Links … Fix Broken Links … View Media Record in Property Box … The Media Window  
Toolbar … Picture  Zooming & Scrolling … Open Editor/Player … Working with Multiple Media Windows … 
The Media Menu … Locate on Disk … Options … View Full Picture … View/Edit Media Record Details … 
Title, Date, Note and Keywords … File Name … File Location … The Links List … Annotating Pictures … 
Clicking on Faces … Attach a Note to a Link … Exclude Picture from Diagrams & Reports … Use Note as 
Caption … Links List Toolbar … Two Ways to Link Faces … Add Frame Link … Add Simple Link … Delete  
Link … Add Frame Only … Select Frame … Order of Links … Show All Frames … Locate in Property Box … 
How to Annotate Picture Details … Media Link Tool … The Records List … Add Links Using  
Drag-and-Drop … The Close Relatives Panel … Show Relatives Of Button … Named Lists … List Filtering … 
Search by Partial Name 

6. Facts & Notes in the Property Box ................................................................................................... 61 
The Facts Tab … What is a ‘Fact’? … Event vs. Attribute … View Facts Tab … Repeated Data … Individual 
Facts & Family Facts … Table of Fact Icons … The Age Column … Show Timeline Facts … Select Timeline 
Facts … Witnesses & Principals … Shared Events … Witnesses Window … You Never Have to Close the 
Witnesses Window … Adding Witnesses … Role Types … Witness Notes … Citing Sources for Witnesses … 
Witnessed Facts … Sentences & Narrative Reports … Sentence Templates … Overriding Default  
Sentences … No Principal and Multi-Principal Events … A Principal Can Also Be a Witness … Witnesses 
with More than One Role … Why Record Each Role? … Add Fact … Auto Complete … Custom Fact Types … 
Fact Sets … Importing and Exporting Fact Sets … Examples of Possible Fact Sets … The Benefits of 
Installable Fact Sets … Accessing the Fact Types Dialog … Priority Ordering of Fact Sets … Importing & 
Exporting Fact Sets … Add Fact (again) … Configuring the Fast Add Menu … Add Multiple Facts … Add 
Multiple Instances of Facts … Copy and Paste Facts … Sorting … Ordering … Re-order Out-of-Sequence 
Data … Normal Time Frame … Move Up & Move Down … Show Media … The Media Viewer … Add Media 
… Drag-and-Drop … Go To … Fact Notes … The Notes Tab … Note Types … Add Note … Editing Shared 



Contents 

iii 
 

Notes … Show Fact Notes … Move Up & Move Down … Go To … The Memo Window 
7. Browsing, Searching & Editing in the Records Window ................................................................ 75 

The Records Window … Individual Records … Column Headings … Configure Columns … Estimated Dates … 
Reset Columns … Sort Records … Filtering … Filter Options … Filter Panes in Other Contexts … Go To 
Record Id … Search by Partial Name … View Property Box … Browse Records by Expanding Branches … 
Family Records … View Linked Records … Records within Records … Go To Record … Delete Record … Cells 
Type and Field Icons … Edit Field … Add Field … Delete Field … The All Tab of the Properties Box … Unlink 
From Parents or Spouse … Remove Any Links … Low-level Editing 

8. Diagram-based Editing ..................................................................................................................... 83 
Following Exercises … Why Diagram-based Editing? … Automatic Source Citations … Trees vs. Diagrams … 
If the Tree Will Show It, You Can Add It … What is a Relative? … Status Bar … Click-and-Drag to Add  
Spouse … Click-and-Drag to Add 2nd Spouse … Click-and-Drag to Add Children … Cancel Click-and-Drag … 
The Dotted Box … Add Child for 2nd Spouse … Change Spouse Order … Change Sibling Order … Re-Order 
Events by Date … Re-Order Out-of-Sequence Data … Crossed Lines … Click-and-Drag to Add Parent … 
Select Multiple Boxes in a Diagram … Deleting Relatives in a Diagram … Make Regular Backups … Undo 
Changes 

9. Setting the Style, Layout & Content of Diagrams ............................................................................ 89 
Open ‘All Relatives’ Diagram … Restore Installation Settings … ‘On-the-Fly’ Changes to Options … Charts 
vs. Working Diagrams … Text: Content, Font and Style … The Text Tab … Name, Date and Place Formats … 
Create Custom … Text Schemes … Clone a Text Scheme … Modify Existing Text Scheme … Changing Fonts 
& Styles … Advanced Text Schemes … Override Text … Show Pictures in Diagrams … The Picture Tab … 
Silhouettes … Pictures and Box Types … Box Features … Catalogue-style Icons … Conditions … The Boxes 
Tab … Presets … The Lines Tab … Crossed-Out Marriage Lines for Divorced Couples … Proxy Boxes … The 
Proxies Tab … The Dimensions Tab … The Diagram Background … Background Picture … Background 
Texture … Sundry Colours … Duplicates … Linking Ribbons … Check for Duplicates … Find Duplicates … Find 
in Diagram … Marking Boxes … Set/Clear Marks Using Query … Diagram Orientation … Standard Diagram 
Types … Diagrams for Couples … Select Family Record in Focus Window … Select Family Record in Records 
Window … Box Alignment … The Everyone Diagram … Fan Charts … Create Custom Diagram Types … 
Modify Custom Diagram Types … Delete Custom Diagram Types … Re-using Diagram Windows … Lock 
Window (prevent re-use) … Charts are Always Locked … Multiple Instances of Workspace Windows 

10. Smart Trees and Wall Charts........................................................................................................ 105 
Wall Charts … The Everyone Diagram … Restore Installation Settings … Diagram Statistics … File  
Statistics … View Descendants … Enable Moving/ Resizing … Resize Box … Box Size Affects Row Size … 
Autosize Box … Five Types of  Drag-and-Move Actions … Box Move … Include Box in Row … Box Move is a 
Branch Move … Align With Others in Same Row … Box Moves Are Outwards Only … Bar Moves … 
Sideways Bar Moves … Box Moves Work with Multiple Selection … The Movement Control Box … Fixed 
Point Moves … Separating Spouses … Separating Siblings … Separating Entire Branches … Cancelling Fixed 
Points … Tree Move … Move Everything & Scaling … Shift Spouses … Shift Siblings … Shift  vs. Move … Hide 
Boxes … Show Hidden Boxes … Unhide Boxes … Smart Trees … Insert into Diagram Submenu … Display 
Shape Toolbar … Multi-Tree Diagrams … Insert Tree … Move Tree After Insert … Trees are Smart, 
Diagrams Aren’t … Front-to-Back Ordering … Check For Duplicates … Importance of Tree Order … 
Limitation of Undo/Redo … Cancel Moving/ Resizing … Tree Type in Status Bar … Delete Tree … Each Tree 
Counts as One Diagram Element … Insert Picture into Diagram … Moving & Resizing Pictures … Rotating 
Pictures … Format Picture … Add Text Box … Format Text Boxes … Insert Rectangle … Insert Rounded 
Rectangle … Insert Ellipse … Insert Circle or Square … Insert Polygon … Add, Delete or Move Polygon 
Vertices … Insert Line … Snap … Add, Delete or Move Line Vertices … Rotating and Resizing Lines … Insert 
Arrow … Insert Pie Shape … Insert Freehand … Shift Key … Ctrl Key … Resizing/ Rotating Multiple Shapes … 
Copy and Paste Shapes … Delete Shapes … Front-to-Back Ordering … Grouping Shapes … Add Fan Chart … 
Fan Chart Base Person … Creating  Custom Diagram … Moving Tree Branches Anywhere … Format 
Multiple Shapes … Format Tree Boxes … Override Box Features … Override Silhouettes … Prevent Linking 
as Duplicate … Layout & Scaling … Matching Box Sizes … Family Connection Mapper … Routes … Connect 
Two Boxes … Multiple Routes … Non-Linking Route Boxes … Multi-Way And ‘Broken’ Paths … Colouring 
Branches … Saving Diagram as Chart File … Charts Only Within Projects … How to Open a Chart … Charts 
are Integrated, Interactive & Dynamic … Charts Reflect the Current Reality … How to Ensure that a Chart 
Doesn’t Change … Saving Charts as Pictures … Saving Charts in PDF Format … Copy Diagram 

11. Scaling & Printing Diagrams ............................................................................................................ 131 
Size, Scale & Boundaries … Open Sample Project … Saving Diagrams in PDF Format … Print Diagram … 
Show Page Boundaries … Position Diagram on Printed Page (1) … Position Diagram on Printed Page (2) … 
Snap to  Page & Row Boundaries … Print Preview … Printing the Background … The Print Tab … Black-and-
white and Colour printing … Landscape vs. Portrait … Scaling … Set Scaling on the Movement Control  
Box … Fit an Exact Number of Rows per Page … Zoom To Actual Size … Scaling a Diagram to Fit a Page  
Size … Avoid Page Boundaries 



Contents 

iv 
 

12. Recording Your Sources .................................................................................................................. 137 
What is a Source? … Source Records & Source Citations … Open Sample Project … The Source Pane … 
Sources For Field … Sources Cited … Citations Details … Add Citation … Source Record Fields … Citation 
Fields … Source or Citation? … Show Media … Copy and Paste Citations … View List of Source Records … 
View Source Record in Property Box … Record Links … Queries for Sources … View All Source Media … 
View Sources for Witness Info … Using the Source Pane with Floating Windows … Go To Source Record … 
Go Back & Go Forward Buttons … Repository Record … Media Tab … Open in Editor/Player … Attaching 
Media to a Source Record … Source Citations for Family Relationships … Source Citations for Parents … 
Source Citations for Spouses … Creating a Source Record from the Add Menu … Automatic Source 
Citations … The Automatic Source Citation Pane … Source Title … Citation Details … Enable Automatic 
Source Citations … Automatic Source Citations Work Everywhere! … Use with Care! … Less and More …  
F5 … Disable Automatic Source Citations … Creating Source Records … And More… … The Help … Ancestral 
Sources 

13. Web Search, Web Hints & Web Clipping ..................................................................................... 147 
Web-Related Tools … Automatic Internet Data Matching … Preferences … Matching in the Focus  
Window … Web Hints … View Match Details … Confirm or Reject … Extract Information … Refresh Internet 
Matches … Manual Searches … Internet Search Tool … Check for Search Tool Updates … Search Now … 
You Never Have to Close It … Search from Workspace Windows … The Web Search Window … Open Web 
Search Window … Why Use the Web Search Window? … Web Clipping … Drag-and-Drop … Web Clipping 
Example, with Drag-and-Drop … Step 1 – Set Automatic Source Citation … Step 2 – Extract Data … Web 
Clipping Example … Drag-and-Drop Tips … Drag-and-Drop Facts … Drag-and-Drop Spouses & Children … 
Drag-and-Drop Parents … The Parents Window … Drag-and-Drop to Add Mother … Drag-and-Drop to Add 
Father … Drag-and-Drop Images … Drop Zones … Drag-and-Drop with an External Browser … Copy-and-
Paste … Bookmarks 

14. Places, Maps and Timelines .......................................................................................................... 155 
Mapping Tools … Automatic Geocoding … Place Records … The Map Window … The List Pane … Menu and 
Toolbar … Navigating and Zooming Maps … Scroll Rose and Zoom Slider … Mouse Wheel Zooming … Click-
and-Drag to Move Map … Marker Sets … Create New Marker Set … Add a Second Marker Set … Switching 
Between Marker Sets … Hide/Show Events … Hide/Show Fact Types … Show Event in Map … Clicking on 
Markers … Popup Marker Window … Find Events Near a Place … Two Marker Set Types … Time Slider … 
No-Date Markers are Hidden … Scroll the Time Slider … Adjust the Slider End-Points … Trouble-shooting 
Marker Problems … Alternative Maps … Save Map As … Displaying Maps in Books & Booklets … Displaying 
Maps in Generated Websites … Geocoding … Legend … Enable Marker Dragging … Drag-and-drop from 
List Pane … Lat./Long. Field in Place Record … Block Geocoding … Press F1 for Help 

15. Reports and Narratives ................................................................................................................ 163 
Reports and Query Reports … The Publishing Tools Finder … The Family Group Sheet … Family Group 
Sheet Layout … The Individual Summary Report … Select Records Dialog … Features of the Select Records 
Dialog … Add to Named List … The Reports Window … The Report Menu … The Reports Window Side 
Panel … Features of the Side Panel Buttons … Using the Mouse Wheel … Save Report as PDF File … Save 
Report as Web Page … Save Report as Word-Processor Document … Save Report as Text File … Styles in 
HTML and Rich Text Format … Save as Custom Report Type … The Records Button … The List Button … 
Report Options … Report Options Tabs … Page Records … Reports are Dynamic … See What You Are Doing 
as You Do It … Rebuild Report … Trouble-shooting Layout Issues … List of Standard Reports … Narrative 
Reports … Narrative Reports - Recap … Sentence Field … Sentence Template … Template Codes … Angle 
Brackets … Modifying the Sentence Field … Sentence Field Background Colour … Template Codes in 
Override Sentences … Reset Overriden Sentences … Modifying Sentence Templates … Fact Definition 
Dialog … The ‘blank’ Template Code … Template Codes and Data References … Insert Data Reference … 
The Data Reference Assistant … The Power of Data References & Functions … Where to Learn More … The 
Descendants by Generation Report … Report Options … One Section Per Descendant … Help on Report 
Options 

16. Books & Booklets .......................................................................................................................... 177 
Some of the Things You Can Do with Books & Booklets … The Books Dialog … The Book Window … Setting 
the Page Size and Orientation … Choosing a Printer … The Edit Book Dialog … Modeless Dialogs … 
Performance Tip … Create a Book … Set Page Size and Printer Details … View Two Books at the Same  
Time … Modify Chapter Settings … Add Free Text Page … Item Settings … Add Free Text Chapter … Add 
Fan Chart … Add Diagram … Diagram Headings … Adding Maps to Books … Saving Book in PDF Format … 
Saving Book as a Word-Processor Document 

17. Introduction to Queries ................................................................................................................ 187 
Overview … What is a Query? … Standard Queries … Relations and Nearest Relationship … The Query 
Window … The Result Set Tab … Sorting the Result Set … Run Query … Run and Invert Result Set … Select 
Record in Result Set … More Standard Queries … Relations and 5 Nearest Relationships … Same Sex 
Relationships … Fact Date Warnings … Data-Linked Cells … Locating Fields in the Property Box … Birthdays 



Contents 

v 
 

(all) … Birthdays (for given day and month) … Search For Orphans … Boys’ Names … Named List  
Members … All Individuals … All Events … All Facts … Print Query as Report … Print Preview … Configure 
Query Reports … Standard Query Descriptions … The Query Toolbar … Cancel Query … Print … Queries 
and Spread-sheets … Select Multiple Cells … Copy Selected Cells … Locate in Property Box … Save Results 
to File … Query Menu … Delete Multiple Records … Delete Multiple Fields 

18. Writing Custom Queries ............................................................................................................... 197 
Custom Queries … New Custom Query … What is a Record? … What is a Field? … What is a Fact? … Save 
As Custom Query … Copy or Rename a Custom Query … Delete Custom Query … The Parent Names 
Sample Query … The General Tab … Title and Subtitle … The Columns Tab … The Column List … The Fields 
List … Add Field as Column … Making Sense of the Field List … How Family Relationships are Stored … 
Traversing Links … Shortcuts … Change Column Headings … Expressions … Handling Multiple Instances … 
The Rows Tab … Add General Filter … How Filters Work … The Result Set and the Input Set … First Filter 
has Exclude Condition … More on Filters … Benefits of  Sequential Filtering … Using Parameters … Using 
Qualifiers … Add Record Id … Re-order Columns … Specify Column Sort … Delete Column … The Born After 
1900 Sample Query … Add Relation Filter … Delete Filter … Re-Order Filters … Relation Filters that 
Reference a Single Individual … Descendants of a Particular Individual 

19. Projects: Compare, Merge, Split, Copy & Export ......................................................................... 211 
Three Kinds of Merge Compare … Always Backup Before File Merge … File Merge/ Compare … Why 
Needed? … The Family Historian Solution … You are In Control … Two-Step Merge … Two-Step  
Compare? … Preparation for Sample Merge/Compare … The Direction of a Merge … Open the 
Merge/Compare Dialog … The Merge/Compare Dialog … The Three Panes … Matched Records … Matched 
and Unmatched Fields … Retained Data and Discarded Data … The Information Pane … The Score  
Column … Family Historian is not Infallible … The Match Column … L+, L-, R+, R- … The Chk Column … All 
Columns are Sortable … The Action Column … Override Family Historian … The Discard Button … The 
Retain Button … The Match and Unmatch Buttons … Restrictions … Only the Merge Button Executes 
Changes … Multiple Selection … Discarding New Data vs. Discarding Old Data … Matching Non-Identical 
Fields … Field Values are Never Merged … Adding, Deleting and Ignoring … Summary … Check All Record 
Types … Execute Merge … Copy Linked Media … Source Citations for a Merge … Save Changes … Splitting 
Projects … Copy Project … The Split Tree Helper  Dialog … Standalone GEDCOM Files … Save a GEDCOM … 
File Copy … Export GEDCOM File … Export Issues with Media … Reset Sample Project 

20. Named Lists and Record Flags ..................................................................................................... 225 
Overview … What are Named Lists For? … What are Record Flags For? … When Should You Use Which? … 
Named Lists Pane … List Item Notes … Add to Current List … New Named List … Remove Item From List … 
Auto-Create Named Lists … Add to Named List … Named Lists and Queries … Differences between Queries 
and Named Lists … Merge Named Lists … Delete Named List … Empty Named List … Delete All Records in a 
Named List … List Reports … Keep Current List Order … Named List Properties … Record Flags Dialog … 
Create New Record Flags … Delete Record Flags … Standard Record Flags … Viewing Record Flags … Low-
level Editing … Flags and Named Lists … Flags and Queries … Add Record Window Column 

21. Website Generation and Other Wizards & Tools ........................................................................ 233 
Overview … The Public Folder … Accessing the Public Folder … Create Website Wizard … Putting it on the 
Internet … Standalone GEDCOM File … Modifying a Website … Make CD/DVD Wizard … The How Related 
Tool … Display Graphically … The How Related Report … Autosave … Backup and Restore … Backup to the 
Cloud … Have a Backup Strategy … Restore from Backup … Plugins … The Plugin Store … Add Plugins to 
the Tools Menu … Write Your Own Plugins … Make Automated One-off Changes to Your Data … Built-in 
Editor/Debugger … Submit Plugins to the Plugin Store … Trouble-shooting 

Index ..................................................................................................................................................... 238 
 





 

1 
 

Introduction 
Check Your 

Software 
Version 

If the version number of your copy of Family Historian begins with a ‘6’, this is the 
right book for you.  If possible, though, you should be on version 6.1 or later.  If 
your version is earlier than 6.1, you can still use the book, but you may notice some 
minor differences between the book and the software; consequently we recommend 
that you install the latest free updates, to bring your copy up-to-date.  
 
You can click Check for Updates on the Help menu to find about the latest 
version.  You can also check your version number by clicking on About Family 
Historian on the same menu. If the version number begins with a ‘6’ and is earlier 
than 6.1, see www.family-historian.co.uk/downloads/latest-free-upgrade for details 
of free upgrades.  

 
The Sample 

Project 
Part of the Family Historian installation is a sample project called ‘Family Historian 
Sample Project’.  It is intended for you to use to try out new features, and to play 
with.  Don’t be afraid to make changes to the data in the sample project.  That’s 
what it is there for.  But don’t store anything in it that you want to keep.  You can 
reset it to its initial state whenever you want to, and it’s often useful to do that.  But 
when you reset it, any changes you make will be lost.  So don’t store anything in it 
that mustn’t be deleted. 

 
Find Sample 

Project & 
Reset It 

To find the sample project, start Family Historian.  If the Project Window doesn’t 
open automatically (it looks like Figure 1 below) click on Project Window on the 
File menu to open it.  You should see a project called Family Historian Sample 
Project in the list of projects.  If you can’t see it, you will need to reset the sample 
project.  Even if you can see it, you are recommended to reset it anyway.  This book 
makes frequent reference to the sample project, and by resetting it, you can ensure 
that the version you are running matches the version used in this book.  To do this 
(assuming that you haven’t made changes to it that you don’t want to lose – see 
previous section) click on the More Tasks button, then Samples, then Reset 
Sample Project.  If you plan to install the latest software updates, as discussed 
above, be sure to do so before resetting the sample project, so that you get the latest 
version of the latter also. 

 
Copy 

 Sample 
Project 

Some of the exercises in this book involve making changes to the sample project.  
You can use the Undo command on the Edit menu to undo these changes one-by-
one if you wish. You can also reset the sample project at any time, using the 
instructions in the previous paragraph.  But if you would prefer not to make changes 
to the sample project at all, there is an alternative, which is to make a copy of it, and 
use that when following the exercises and examples in this book.  To copy a project, 
open the Project Window, select the project you wish to copy, and click on the 
More Tasks button.  Then click Copy Project on the dropdown menu that appears.  
Modify the Name of Copy field to ensure the copy gets a unique name (such as 
“Family Historian Sample Project (2)”) and press Copy. 

 
GEDCOM Occasionally in this document you will find references to GEDCOM.   This is the 

name of the world-wide standard file format for shared genealogical data.  When 
you send or receive genealogical data from other people, the most common way of 
doing this is to transfer the data in the form of a GEDCOM file.  Family Historian is 
100% GEDCOM-compatible, and 100% GEDCOM-complete – that is, it can load 
all GEDCOM (5.5) fields and can save all of its data to the GEDCOM format.  In 
fact, Family Historian uses GEDCOM internally as the format in which it saves 
data. 
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Transferring 
Data into 

Family 
Historian 

To learn how to transfer data into Family Historian, read the section Create a New 
Project at the end of Chapter 1.  During project creation you will be given the 
opportunity to import data from a GEDCOM file, or directly from another 
genealogy program.  If you want to merge the data into an existing project, use the 
Merge/Compare command on the File menu (see Chapter 19 for more on this). 

 
Projects As we will see, the normal, recommended way of working with Family Historian is 

to create a project to store your genealogy research.  You can have as many projects 
as you like, but it is quite common to have only one, and store all your data in that.  
You will be shown how to create a new project at the end of Chapter 1.  When you 
create a new project, Family Historian will create a folder on your hard disk for your 
project, to manage all files relating to your project for you. 

 
Standalone 

GEDCOM 
Files 

You can also use Family Historian to view and edit GEDCOM files.  When a 
GEDCOM file is not part of a Family Historian project it is called a standalone 
GEDCOM file. Bear in mind that even when you are working on a Family Historian 
project, your data is still stored in a GEDCOM file, within the project folder. 

 
The Help Do not forget to use the Family Historian Help.  If there isn’t a Help button 

available, pressing F1 will usually produce help which is relevant to the current 
context.  The Family Historian Help is often the best place to go for detailed help.  
But it also contains more general information and tips, some of which is not 
available elsewhere.  
 
You can also open the Help by clicking on Family Historian Help on the Help 
menu within the program.  The Help has a contents page, an index and a search 
facility.  You are recommended to browse through the top-level items in the 
Contents page, and to drill down to explore topics in more detail – either by 
expanding sections in the Contents page, or by following links within Help pages. 

 
“How To” 

Help 
Within the Help section ‘Using Family Historian’, the ‘How to’ section has 
numerous pages devoted to how to do things.  If you are unsure how to do some 
task, this is the first place to look in the Help. 

 
Terminology Certain windows in Family Historian are called ‘dialogs’. A dialog – also known as 

a dialog box – is a form-like window. Typically a dialog contains boxes (sometimes 
called fields) where you can enter data.  It may also contain buttons you can press 
and options you can tick. 
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1                  Getting Started 
with the Focus Window 

 
Chapter 

Overview 
This chapter gives an introductory tour of some of the central features of Family 
Historian, based around the Focus Window.  It ends by showing you how to create 
your first project. 

 
The Project 

Window 
Before looking at the Focus Window, we must first look at another window that has 
already been mentioned in the Introduction: the Project Window – see Figure 1 
below.  This is the window you will see when you first open Family Historian.   The 
Project Window lists all of the Family Historian projects in the specified location.  
When you first install Family Historian there will only be one project:  Family 
Historian Sample Project.   

 
 

 
Figure 1 – The Project Window 

 
 

The Family 
Historian 

Sample 
Project 

The Family Historian sample project was discussed in the Introduction  (if you 
skipped the Introduction, please go back and read it now as it contains important 
information).  The people mentioned in it are all fictitious. 
 
Select the sample project now by clicking on it and then clicking on Open Project.  
Alternatively, you can also open it by double-clicking on the name ‘Family 
Historian Sample Project’ in the list.  When you do this, the Project Window will 
close and you will see a screen like Figure 2 below. 
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Figure 2 – The Sample Project with Three Marked Areas 

 
The 

Navigation 
Bar 

 

The main body of the window in Figure 2 is made up of three areas: 
 

• The Navigation Bar 
• The Focus Window 
• The Property Box 

 
Of these, the Navigation Bar is much the thinnest.  It is the vertical 
grey bar on the left side.  The top part of it is shown in  
Figure 3 on the right.   
 

 
 

Figure 3 – the 
Navigation Bar 

Workspace 
windows 

 

The Navigation Bar shows one icon for each open workspace 
window within Family Historian.  A ‘workspace window’ is a 
window within a window – in this case, within the Family Historian 
main application window.  The Focus Window is an example of a 
workspace window.  The ‘active’ workspace window is highlighted 
in the Navigation Bar.  Click on any workspace window icon to 
make that window active – that is, to switch between windows. 

 
 You can also right-click on any Navigation Bar icon to see a menu of things you 

can do with the window it represents.  The last item on this menu is the Close 
Window command. 
 
The first icon in Figure 3 is the magnifying glass icon which represents the Focus 
Window.  The second icon (a database icon) is the Records Window icon.  The 
Records Window – another workspace window – is not yet open.  This is the 
exception to the rule that the Navigation Bar shows open windows.  For 
convenience, the Records Window always has an icon on the Navigation Bar, even 
if closed. 
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We will look at the Records Window presently, and also other workspace windows, 
each of which has their own distinctive icon in the Navigation Bar. 
 
The Navigation Bar is similar to the task bar in Windows.  The task bar is the bar at 
the bottom of the screen, showing application icons.  Clicking on application icons 
on the task bar lets you switch between open applications.  Clicking on workspace 
window icons on the Navigation bar lets you switch between open workspace 
windows within the Family Historian application. 

 
 

 
Figure 4 – The Focus Window: Spouses & Children Tab 

 
 

The Focus 
Window 

 

The second of the marked areas in Figure 2 is the Focus Window (see Figure 4 
above).  The Focus Window shows information about a particular person, called the 
focus person, shown at the top of the window.  In this case, the focus person is Ian 
Stephen Munro.  There are three photos of Ian Munro, also shown at the top of the 
window.  You can show up to 9 photos here if you wish, and if there is space.  
Don’t confuse the term focus person with the term root person.  As we will see 
later, they don’t mean the same thing. 
 
In the area immediately below this you should be able to see 4 tabs.1  These are 
Spouses & Children, Parents & Siblings, Ancestors and Descendants. 

 
The Spouses 

& Children 
Tab 

 

The Spouses & Children tab shows all of the focus person’s spouses and children.   
In this particular case we can see that Ian Munro has one spouse only.  If there were 
others, they would be shown.  His wife is Charlotte Carrington, with whom he had 
3 children: Christopher, Janet and Paula.  Ian Munro himself also appears in the 
Spouses & Children tab, in the box next to Charlotte Carrington.  His box has a 

                                                           
1 The term 'tab' is used in this book for two quite different things.  You will frequently see it used to 
refer to Tab key – a key on the keyboard, usually positioned just above the Caps Lock key.  In this 
usage, Tab is written with a Capital and emphasized in bold.  The other use of the term is to refer to a 
tab in a tabbed dialog box, or tabbed window, such as the Focus Window.  When used in the latter 
sense, tab is spelled in lower-case, and is not in bold. 
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dark blue border round it, to show that this person is the focus person. 
 
As well as showing Ian Munro himself, his spouses and his children, this tab also 
shows both of Ian’s parents, and his spouses’ parents. 

 
Select a 
Record 

Within the Focus Window, you can select any record (that is, any person) by 
simply clicking on the box or row that represents that person.  The selected box is 
indicated by a darker than normal background colour.  When you select a record, 
the Property Box changes to show you information about that person.  We will be 
looking at the Property Box in the next chapter. 

 
Set the 
Focus 

Person 
 

You may have noticed that nearly all the boxes have a little picture of a magnifying 
glass in the bottom-left corner.  Click on this magnifying glass to make that person 
the focus person – or just double-click on their box.  Use either technique now to 
make Ian Munro’s mother, Susan Dowling (S.I. Dowling in Figure 4) the focus 
person.  When you do this, the Focus Window should change to look like Figure 5. 

 
Multiple 
Spouse 

Families 

Figure 5 shows what the Spouses & Children tab looks like when the Focus Person 
has more than one spouse.  Susan Dowling married twice, so the window shows 
both of these families.  She had four children, Judy, Ian, Sally and Nigel, with her 
first husband, Anthony Munro.  He died in 1998, and in 2001, she married Nigel 
Anderson.  They had no children. 
 
As can be seen by this example, the focus person gets his or her own box in each 
family, and each such box has a dark blue border.  The boxes for his/her parents are 
also repeated.  This way, each family is shown with all members present, including 
grandparents, and it is easy to see at a glance, who was married to whom, and, for 
any given child, who their parents and grandparents were.  

 
Add Parents You can see from Figure 5 that Susan Dowling’s father was Richard Dowling.  But 

her mother is not given.  Instead there is just the words “Add Susan’s Mother” in 
light-coloured text.  This is a link.  When you click on this link – the actual text, not 
just the box – a menu appears with two menu commands: Create New Record and 
Link Existing Record.  If you choose the former, Family Historian will create a 
new record for you, and link this record to Susan as her mother.  You can then type 
in the name of this person, and any other details about her, in the Property Box (we 
will be looking at the Property Box in more detail later).  If you choose the latter, 
Link Existing Record, Family Historian will let you select from your existing 
records, and link the selected person as Susan’s mother. 
 
Actually, there are two boxes in this particular case, which have the text link “Add 
Susan’s Mother” – one for each family.  Both links work exactly the same way.  It 
doesn’t make any difference which you choose. 

 
Undo/Redo 

 
Try it now.  Click on “Add Susan’s Mother” (either box).  Then choose Create 
New Record.  Immediately, the text for Susan’s mother’s box changes to show 
“[unnamed person]”.  Notice that this changes in both boxes.  Ordinarily you would 
go on to add a name for the new person in the Property Box, but we aren’t ready to 
look at the Property Box yet, so instead of doing that, let’s just undo what you just 
did.  Click on the Edit menu.  The first item on this menu is Undo Create Parent 
[123].  123 is the record id that was allocated automatically to the new record you 
created.  Click on this menu command now.  When you do this, the new record you 
created for Susan’s mother is removed and the box for Susan’s mother reverts to 
showing the link “Add Susan’s Mother”. 
 
Using the Undo/Redo commands on the Edit menu, you can undo and redo almost 
any change you make to your project data: creating new records, deleting records, 
and any edits you make to records – they can all be undone or redone.  So don’t be 
afraid to experiment! 
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The Focus Window doesn’t just let you add parents for the focus person.  You can 
also add parents for their spouses too.  For example, you can add either father or 
mother for Nigel Anderson by clicking on the links “Add Nigel’s father” or “Add 
Nigel’s Mother”. 

 
 

 
Figure 5 – The Focus Window (Spouses & Children tab) with Susan Dowling as the focus 

person.  She had two spouse families. 
 
 
Add Children You’ve probably already guessed how to add children.  If you want to add a child 

for Susan Dowling and Anthony Munro, click on the “Add Child” text link in the 
row immediately below their last child, Nigel Munro.  If you want to add a child for 
Susan Dowling and Nigel Anderson, click on the “Add Child” text link in the 
otherwise empty area where their children would be listed if they had any. 
 
Whenever you click on a text link for adding any kind of relative, you will always 
be given the choice of creating a new record for the new relative, or linking to an 
existing relative. 

 
Add Spouses Adding a person’s first spouse in the Focus Window is always easy.  They will 

always have a box next to them where the spouse should go and there will be a link 
you can click labelled “Add Husband/Parent” or “Add Wife/Partner”.  But what if 
the person already has a spouse?  How do you add another one? 

 
Add More 
Relatives 

Below the last box in the Focus Window is another text link: “Add More Relatives 
for Susan Isabel Dowling”.  You can always click on this link to add relatives, if 
there isn’t a handy box to click in.  You can use it to add more spouses for the focus 
person.   
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You can also use it in other circumstances.  Suppose, for example, that you wanted 
to add a child for Susan Dowling, but neither Anthony Munro nor Nigel Anderson 
were the father.  In that case, you could use the “Add More Relatives” link, and it 
would let you pick the father – either an existing record or a new one. 

 
Add More 

Sets of 
Parents 

In Family Historian, a person doesn’t have to have just one set of parents.  They 
can have as many as you like.  They might have birth parents, foster parents, 
adoptive parents, and so on.  You can use the “Add More Relatives” link to add 
additional sets of parents. 

 
Add 

Relatives 
Using the 

Add Menu 
 

Another technique for adding relatives is to use the Add menu.  You can always 
add relatives of any kind for anyone using the Add menu.  Just remember to first 
select the person who you want to add a relative to. 
 
If a person has more than one box in the Focus Window, which can happen whether 
or not they are the focus person, you can select them (select their record) by 
clicking on any of the boxes for them.  It doesn’t matter which one you choose. 

 
Add 

Unrelated 
Person 

 

When you add new people to a Family Historian project, most of the time you will 
be adding them as relatives of people that you have already added.  But the people 
you add don’t have to be relatives.  If you want to add a person who is not related 
to anyone already in your project, click on the Add menu, and then Unrelated 
Individual. 

 
Add Grand-
parents and 

Grand-
children 

There is no facility to add grandparents or grandchildren as such.  There is no need 
for it. All relationships effectively reduce to combinations of parent-child and 
spouse-spouse relationships.   So you don’t need to enter a grandparent for a 
person.  Simply add a parent, and then add a parent for that parent.  Equally to add 
a grandchild, add a child, and then a child for that child. 

 
Go Back & 

Go Forward 
Buttons 

  
     
 

The Focus Window has its own Go Back and Go Forward buttons.  These are in 
the top-left corner, just to the left of the ‘Spouses & Children’ tab.  They are greyed 
when there is no-one to ‘go back’ or ‘go forward’ to.  Try using them now.  At this 
point, if you have been following everything carefully, Susan Dowling should still 
be the focus person, and the Focus Window should look like Figure 5 above.  The 
left arrow button is the ‘go back’ button and it should be ungreyed now.  Click on it 
to ‘go back’ to the previous focus person.  When you do this the right arrow 
becomes ungreyed.  Click on this to ‘go forward’ again, to return to where you have 
just been. 

 
The Home 

Button 

 
 
 

A very useful button is the Home button.  This is on the left side of the main 
application toolbar.  Click it now to switch back to showing Ian Munro as the focus 
person. 
 
As we will see later, at any given time, there are several other windows that you 
could be viewing, apart from just the Focus Window.  Even if you had been viewing 
one of these other windows, the Home button would still be visible on the toolbar, 
and clicking it, it would jump you back to the Focus Window, with the root person 
as the focus person.  So who or what is the root person?   

 
The Root 

Person (the 
File Root) 

 
 

In every Family Historian project, you can specify that one person is the root person 
or file root.  The two terms mean the same thing.  There are various benefits to 
making someone the file root.  For example, when Family Historian opens a project, 
it will always initially show the Focus Window with the file root as the focus 
person.  In the focus person box (the box at the top of the Focus Window), it will 
always show how the focus person is related to the file root, if they are related.  If 
the focus person is the file root, it will just say ‘Root Person’.  As we have seen, 
when you click the Home button, it jumps you back to the file root. 
 
There are other benefits, but these will do for now. 
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Make File 

Root 
 
 

You can change file root very easily at any time. When you’re viewing the Focus 
Window, you just need to right-click2 on any person and a menu appears.  The first 
command on this menu is always Make File Root. 
 
Ian Munro should be the current focus person.  In the box for him at the top of the 
Window, it should have the text “Root Person”.  Right-click now on Ian’s wife, 
Charlotte Carrington and make her the file root.  When you do this, she doesn’t 
become the focus person – that is still Ian Munro.  But if you look at the box for him 
at the top of the window you should see that instead of “Root Person”, it now says 
“Husband of Charlotte CARRINGTON”. This is because Charlotte Carrington is 
now the file root. 
 
To make Ian Munro the file root once again, you could just click on Undo File Root 
Change on the Edit menu.  Or you could right-click on Ian Munro’s box and click 
on the Make File Root command in the menu that appears.  Choose either of these 
options now, and make Ian Munro the file root once again. 
 
If you aren’t using the Focus Window when you wish to make someone the file 
root, you don’t have to switch to the Focus Window specially to do this.  Just select 
the person who you wish to make the file root, and click on the Edit menu, then File 
Root and Set as File Root. 

 
The Focus 

Button 

 

Another useful toolbar button is the Focus button.  This button is just to the right of 
the Home button.  If you select a person and click the Focus button, that will show 
the selected person as the focus person in the Focus Window.  You may be 
wondering why that’s useful.  Why not just double-click on the person’s box or 
click on their magnifying glass to make them the focus person?  Bear in mind that 
those options are only available when you are viewing the Focus Window, and as 
we have already mentioned, there is much more to Family Historian than just the 
Focus Window. 
 
You may also be wondering what the difference is between the Focus button on the 
main toolbar, and the Focus Window icon (the magnifying glass) in the Navigation 
Bar (see Figure 3 above).  The difference is that the toolbar Focus button only works 
when you have first selected a person.  When you click on the Focus button, it 
activates the Focus Window and makes the selected person the focus person. 
 
No selection is required when you click on the Focus Window icon in the 
Navigation Bar.  The Focus Window doesn’t change at all when you click on this 
icon.  It is merely activated.  That is, if it is hidden because other windows are in 
front of, it is moved in front of those other windows – but that is all.  So if you want 
to go back to the Focus Window without changing its contents, you need to click on 
the Focus Window icon.  Another difference is that you can right-click on the Focus 
Window icon, as you can with any icon on the Navigation bar, and a menu will 
appear, showing you actions that you can take with the window in question.  Right-
clicking on toolbar buttons doesn’t do anything.   

 
Adopted, 
Fostered,  
Step, etc. 

You should by now know how to make Ian Munro’s mother, Susan Dowling, the 
focus person.  Do so now.3  The Focus Window should once again look like Figure 
5 above.  Look at the rows for the four children of Susan Dowling and Anthony 
Munro.  The rightmost column is labelled ‘Rel’.  This is short for ‘Relationship to 

                                                           
2 In this document, whenever you see the phrase “right-click” this just means “click using the right 
mouse button”. 
3 If you can’t work out how to do it, here are some suggestions:  if you can see her box, double-click on 
it, or click on the magnifying glass in the corner of the box.  If you can’t see her box, click the Home 
button which should take you back to Ian Munro as focus person, and she should be visible.  Now 
double-click on her box. 
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